
Guidance for Developing Accessible Resources for MIPN 

The purpose of this document is to help ensure that MIPN resources are accessible to a broad 
audience. MIPN has developed this document for its own internal use to improve the  
accessibility of our website, social media content, publications, slideshow presentations,  
webinars, conferences and other events. The sources we have referenced in developing this  
guide include the Government Service Agency (GSA), the U.S. Access Board, the Americans  
with Disabilities Act (ADA), and the Architectural Barriers Act (ABA). More information and links  
to these sources can be found in the Appendix, along with a step-by-step guide to PDF  
remediation.   

Section 1 - General Guidelines 

1.1 - Visual Accessibility 

1.1a Accessible Colors   
● Color blindness, or color vision deficiency, affects 8% of men and 0.5% of women.

There are different types of color blindness1 (red-green, blue, or no color)
● An important aspect of color for both low vision and colorblind users is sufficient

contrast between the foreground text and the background. Never use color as the only
method of meaning or emphasis.

● Make sure to bold text (emails) or use text or symbols, in addition to color, in images
and tables to ensure your information and meaning is clear to all.

● Use a color palette that is accessible to the audience you are trying to reach. MIPN
has set up a colorblind palette in Canva. The National Center for Ecological Analysis
and Synthesis (NCEAS) Science Communication Resource Corner has created a pdf
of colorblind safe color schemes2.

1.1b Accessible Text 
● Choosing a font3 

○ In general, choose sans-serif fonts, or fonts without serifs, which are the small
lines or flourishes attached to letters. In the example below the “T” on the left is
sans-serif. Adobe has a nice explanation of the difference between serif and sans
serif4.



○​ Some examples of sans-serif fonts available in Microsoft Word are Arial, 
Calibri, Verdana, and Century Gothic  

○​ Canva5 has a list of sans-serif fonts 
○​ Additional examples include Clearview, Helvetica, Futura, Aptos, and Lato 

●​ Text must contrast with the background  
○​ Standard size text must have a contrast ratio of 4.5:1  
○​ Large text must have a contrast ratio of 3:1   

■ Large text means 14 pt. bold or 18 pt. regular weight or larger  
○​ To test color contrast, the GSA recommends a downloadable tool6 from a 

company called TPGi.   

1.1c Alternative text – also see Section 2.2a  

The Social Security Administration (SSA) created a guide for Alternative Text for Images7.  
Alternate (Alt) text may not always be needed; it depends on the type of image. Guidance 
from the  SSA addresses three types of images:  

1. Informational  
a. Provide essential information that is not mentioned in the adjacent text  

i. Alt-text is always needed 
ii. Do not repeat caption when creating alt text  

2. Redundant  
a. Contain information that is repeated/duplicated in adjacent text or added as a 

caption associated with the image   
b. Alt text is optional, but MIPN opts to add alt text and captions because they  

each support the text in different ways  
3. Decorative  

a. Do not contribute to the adjacent text or overall message of the document; 
they are solely background/decorative images  

b. Alt text is not needed   

Creating Alt Text  

●​ AI can be a helpful tool to generate suggestions for alt text, but AI generated text should  
not be automatically adopted as the final version.   

●​ Keep alt text short, focused, and avoid repeating information in the text body or in the  
caption.  

●​ When deciding what to write for alt text, think about the purpose of the image, not what 
the image looks like.  

●​ Don’t say “image of…” in the alt text description  
●​ Do not include hyperlinks in image alt text. Alt text can be read by a screen reader, but a  

link cannot be acted upon.  
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Section 1.2 - Inclusive language  
A good resource on inclusive language is the American Psychological Association’s (APA) Brief  
Guide to Bias-Free and Inclusive Language8. More in-depth guidance can be found on the APA  
website9 and from the National Center on Disability and Journalism10.   

●​ To avoid bias regarding age, disability, gender, race/ethnicity, sexual orientation, or  
socioeconomic status, make efforts to describe people at the appropriate level of  
specificity and focus on relevant characteristics.  

●​ Call people what they call themselves  
●​ Use gender neutral terms including “they” for a generic person and use gender neutral  

occupational terms such as member of congress, firefighter, or chairperson 
●​  Be Inclusive of all pronouns  
●​ Don’t define people by their disability, appearance, identity, etc.  
●​ Be conscious of cultural backgrounds  

○​ Be mindful of terms like foreign or invaders when talking about invasive 
species 

○​ Use images with inclusive clothing   
●​ Be conscious of audience literacy. For information intended for a broad public audience,  

readability should not exceed the 7th to 8th grade level (according to the Environmental  
Protection Agency11). The federal standard for critical information (such as medication  
instructions) is a 4th-6th grade level. The Flesch-Kincaid Readability Test is incorporated  
into Microsoft Word.  

Section 2 –Guidance for Documents and Publications  

This section provides guidance for outreach publications and other documents generated for  
public consumption. The goal is to create documents that are accessible to and usable by  
individuals with disabilities, either directly or by supporting the use of assistive technology.   

2.1 Word Documents  
Using consistent, accessible styles, image captions and alt text is key to formatting a Word  
document that is accessible and sets you up to have an accessible pdf.   

2.1a Microsoft Office Styles  
Using styles in Word structures the document in a way that ensures formatting consistency  
throughout the document. This structure provides an easier way for all users to navigate the  
document, as well as makes it accessible to assistive technology to read in a logical order. It  
also makes document organization more apparent to screen readers by more clearly identifying  
headings, the start of new paragraphs, etc.   

Styles can be accessed at the top toolbar from the Home tab. The dropdown provides a list of  
available styles to use and can be selected prior to typing content, or selected after by 
highlighting the text to change. Opening the navigation pane allows you to view what content  
within the document is using styles.   
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2.1b Accessible Formatting  
●​ See sections 1a.1 and 1a.2 for guidance of selecting accessible fonts, colors, and 

contrast.  
●​ If the document contains informational or reference images see section 1a.3 for 

guidance on adding alt text.  
○​ Captions and alt text should be limited to 120-150 characters or fewer 

per Maine’s Public Universities12, Ohio State University13, University 
Press of Colorado14, GSA15. Some screen readers cut off text after 125 
characters.  

2.1c Hyperlinks  
- Hyperlinks must describe their destination, function, or purpose either in the text 

surrounding the link or by using a hyperlink  
- Hyperlinks should be descriptive and should not include the full web address - 

Inaccessible hyperlink example: “https://docs.google.com/document/a1b2c3” - 
Accessible hyperlink example: “Accessibility Procedures Guidance Document”  

2.1d Exporting  
Export the document in .docx to preserve accessibility functions for use in other programs. The  
document should also have a descriptive file name. Using styles helps maintain structure and 
accessibility features when converting docs to pdfs.  
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2.2 PDF Files  

PDFs are used for multiple reasons, such as to create a more professional document, to ease 
distribution, and to condense file size. For the educational and outreach purposes of MIPN,  
PDFs often take on the look of a one-page fact sheet, flier, or brochure. Other formats may   
also be written reports full of only text or a combination of text and images. Often, we create 
documents  and fliers in other programs and then convert them into PDFs, which can 
inadvertently create  more work involved to remediate a pdf later to ensure it is accessible.   

Before converting a source document into a PDF, it should be accessible (follow general  
guidelines in section 1.1). If the PDF is not accessible post-conversion, the following items may  
be used as a checklist to improve accessibility post-conversion. Detailed steps for complete 
pdf remediation are detailed in the Appendix B.   

2.2a Alt text for document images, figures, and logos   
For users accessing PDFs digitally, some documents may have images or figures. Follow the 
general guidelines in Section 1.1 and use best judgment to  determine the type of image in 
the document.   

Alternative text for this image might say: “A patch of plants with vibrant green leaves and pink  
and white flowers. The plants are growing next to a downed-tree.”  

2.2b Descriptive captions  
Captions are designed to “describe the purpose or function” of the image or figure. (GSA,  
Accessible Electronic Documents Community of Practice (AED COP). Be sure to include  
captions when you have an image that was specifically called out in the text. When there is a  
figure (i.e., a graph or other chart), a caption should be included to provide the reader context  
and describe the purpose of it.   
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A caption for this image might say: “White and nodding trilliums growing in a forest”.   

2.2c Page orientation  
Occasionally, documents such as brochures are converted to PDFs and available to users to  
download and print at home. Sometimes, the orientation of the page is not correct to account for  
folding the paper once it has been printed. A digital document such as a PDF should have the  
correct page orientation so it is visually correct and any assistive technology can “read” the  
page in the intended order.   

Page orientation can be edited from the sidebar by clicking on the “Page Thumbnails” icon.  
Once the sidebar opens with the thumbnails, select the page with incorrect orientation and use  
the rotate arrows to adjust until it is correct.   

2.2d PDF Tags   
An element to PDF documents is the tags layer. The Tags layer “displays the Tags Structure  
Tree which establishes the logical structure of the document, as well as the logical reading order  
for assistive technology” (AED COP guidelines). There are a number of tags that can be  
implemented in a document, but some of the most common ones are listed below.  

A.​ Artifact  
B.​ Caption  
C.​ Document  
D.​ Figure  
E.​ Heading (levels 1-6)  
F.​ Link  
G.​ List and list items  
H.​ Paragraph  
I.​ Part  
J.​ Quote  
K.​ Reference  
L.​ Section  

The structure of the tag tree depends on the content. A standard letter document might only use  
a few tags because of its simplicity. A detailed brochure with many supplemental graphics  and 
images may require a more complex use of tags. Tags must be organized in a logical reading 
order.   

When creating new documents (including sources other than PDF), it is recommended you  
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utilize features of authoring tools to create an accessible document that can be converted and  
easily edited by Adobe (or similar program). For example, using the “Styles” feature in Microsoft  
Word to set formatting for the document can allow Adobe to automatically identify components  
of the document and tag them (see section 2.1a). Using the “Heading” in Word should allow  
Adobe to pick up that data and display the same thing in the tag layer of the PDF. The auto 
tagging feature of Adobe programs is not perfect, so creators should verify that all tags in the  
tags layer are appropriate and in a logical order.   

Additional information:   
a. Tags don’t need to be nested over and over within each other. Simple tagging makes it 

easier for the assistive technology to do its job.  
b. Empty tags from artifacts can be deleted (see section 2.2h) 

2.2e Visual/Logical Order of the Document  
For documents to be accessible, the order of elements on the page must be organized in a  
visual/logical manner. The logical reading order determines the order in which assistive  
technology can access the content, so the elements must be ordered in a way that make sense  
to read. The order of the tags in the tags tree determines the proper logical reading order for  
the document.   

The logical and visual order of the elements within the document can be changed using the  
Content and Order panel, in collaboration with the Tags panel, from the sidebar in Adobe  
Acrobat. In the panels, elements can be moved by clicking and dragging (up or down) to  
reorder. From the reading order panel, check the box next to “Show page content groups” and  
“page content order” to view contents in a numbered order.   
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2.2f Descriptive file name  
The document’s file name should identify the document or its purpose. For example, a file name  
titled “Brochure” is not accessible because that is not sufficient information to determine the  
purpose of the document or identify it. A better example of a document file name would be  
“Invasive Plants of the Midwest Brochure_2018”.   

File names for PDFs can be changed by clicking “File” ⇒ “Save As” or by changing the name of  
the document where it is saved locally. Document titles should also be descriptive and can be  
changed in the Properties panel. In Adobe Acrobat, click “File” ⇒ “Properties” ⇒ “Description”  
tab to edit the document title.   

2.2g Document has a language set  
The document properties should be set to the primary language the document is written in. In  
Adobe Acrobat, click “File” ⇒ “Properties” ⇒ “Advanced” tab. The document’s language settings  
are listed under the “Reading Options” section. Ensure that the language of the document  
matches what is selected from the dropdown, or change the language if needed.   
 

2.2h Decorative elements are shown as “artifact”  

Decorative elements can be things such as background images, shapes, symbols, etc., that  
don’t contribute to the information presented in the document. Decorative elements should be  
tagged as “artifacts” so that assistive technology does not read or describe it. Identifying  
decorative elements as artifacts will remove them from the tags tree and leave an empty tag in  
its place (the empty tag can then be deleted to reduce clutter).   

For example, the page below is part of a guidance document for land managers to restore  
natural areas. There are many decorative elements on this page:   

A.​ Colored rectangles behind the page title, footer, and below the header  
B.​ Three colored squares behind the paragraphs near the bottom of the page and the 

three symbols in each (microscope, bird, and DNA strand)  
C.​ Small leaf symbol below the title  
D.​ Three leaves in the background of the section on choosing seeds/stock  
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If Adobe Acrobat does not auto-tag the elements, tags for decorative content can be added  
manually. Upon creation or remediation of the document, the user should verify that all  
decorative elements have appropriately been marked as “artifact”. Decorative elements that are  
images do not need to contain alternate text.  

Section 3 – Guidance for Presentations, Social Media, and Websites  
This section provides guidance for presentations, both in-person and online, social media  
content, websites, and conferences. The goal is information sharing that is accessible to and  
usable by individuals with disabilities, either directly or by supporting the use of assistive  
technology.  
 
 

10 



3.1 Slideshow Presentations  
●​ Use accessible font, a colorblind friendly palette, and accessible contrast in slide 

design (see section 1.1)  
●​ Use a minimum of 22 pt. font for text body  
●​ While the common guidance for slides is that less text is better, keep in mind that 

including some explanatory text on a slide can help people that are hard of hearing 
and/or multilingual follow along with the presentation in another way and not solely 
rely on hearing the speaker  

●​ Choose a slide layout provided by the software so a screen reader understands 
the proper content order. Additional guidance is here1.  

●​ Each slide should have a title  
●​ Arrange slide content in the order you plan to present  

○​ This can be done by using the “Select Pane” tab. The pane will show every 
object on the slide. Highlighting an object in the pane will also highlight it in the 
slide. The reading order for the elements in the page is bottom to top. To 
reorder an item, simply click and drag. PowerPoint for Windows also has 
up/down arrow buttons that can be used to reorder items.  

●​ Use simple or minimal transitions/animations and avoid flashing 
content 

●​ If slides will be made available for downloading:  
○​ Save file as a PDF  
○​ Include page numbers  
○​ Add alt text and captions to images and figures (see sections 1.1c, 2.2a, and 

2.2b)  
●​ For in-person presentations, consider providing printable handouts to accompany 

the presentation.  

3.2 Videos/Webinars  
●​ Follow the guidance in section 3.1 for formatting webinar 

slideshows 
●​ Captions for Recorded Content16   

○​ Use sans serif, size 18 pt. font, with white text on black translucent 
background ○ Synchronize captions to speech  

○​ Display only 1-2 lines of captioning on the screen at one time  
○​ Limit the number of characters being used at a time. 45 characters is 

the maximum recommended by GSA.  
○​ Use correct grammar and punctuation  
○​ Add captions for sounds that are not spoken (e.g., sound effects, 

background noises)  
○​ Identify the speakers as dialogue progresses. The name of the speaker should 

precede the text that follows until the next person starts speaking; continue 
this throughout the entire video/webinar.  

■​ This may not be possible with real-time captions that are 
auto-generated by the streaming program  

●​ Transcripts16  
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○​ Follow guidelines from captioning to determine what should be transcribed           
Make sure the transcript is in an accessible format (see section 1.1)  

○​ The transcript should be posted to the same location as the video or 
recording 

○​ Identify the speakers within the dialogue  
●​ Use streaming services, such as Zoom, that offer real-time captioning and 

subtitle options  
●​ Make recordings available to the audience after the webinar ends. This allows viewers 

to rewatch at other speeds and to review information that was unclear or missed during 
the live webinar  

3.3 Social Media  
●​ Design visually accessible content (see section 1.1)  
●​ Use inclusive language (see section 1.2)  
●​ Avoid flashing content  

●​ Use hashtags and use capital letters for multiple words (e.g., #InvasiveSpecies, not 
#invasivespecies) 

●​ Add hashtags to categorize your content, making it discoverable to a wider audience 
beyond your followers who are actively searching for topics related to those hashtags 

3.4 Websites   
 

●​  Key points and page highlights should be easy to find on the webpage 
●​  Use accessible font, a colorblind friendly palette, and accessible contrast (see section 

1.1)  
●​ The University of Georgia used WAVE17 and Colorblindly to help ensure visual 

accessibility of the new (2025) MIPN website  
●​ Include captions and alt text for figures and images (see sections 1.1c, 2.2a, and 2.2b) 
●​ Make hyperlink text descriptive1  
●​ Verify that webpages are formatted for desktops as well as mobile devices  
●​ Pages should be organized according to headings to help screen reader users and those 

with cognitive disabilities. All pages should at least have a <h1> level heading giving the 
title of the page.  

●​ Provide a generous size for clickable areas, generally no smaller than 44px by 44px.  
●​ Provide multiple ways to reach any page on a site to allow users to choose a method that 

is easiest for them. Per Yale University18, users with low vision may find using search 
easier than navigating through a large menu. Users with cognitive impairments may 
prefer a table of contents or site map over clicking through many pages. Common ways 
of supporting navigation include:  

●​  links to related pages  
○​ table of contents  
○​ site maps  
○​ search function  
○​ linking to all other pages from the home page  
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Conferences and Similar In-person Events  
Information in this section is based on MIPN’s experiences hosting the Upper Midwest Invasive  
Species Conference and from insights from presentations provided by Dr. Shikha Singh on April  
9, 2024 (JLW CISMA and MIPN board member). Try to anticipate needs and have resources  
ready to reduce the chance that people will feel that their needs are a burden. 

●​ General accessibility considerations for in person events  
○​ Ensure adequate handicap parking 
○​ Provide public transportation access  
○​ Post signage with large print (a good rule of thumb is 1” of letter height for every  

10’ of viewing distance) 
○​ Be familiar with the nearest medical care facility  
○​ Build in enough time for those who need frequent bathroom breaks or who may  

be dealing with chronic pain issues. Remember service animals need breaks too.   
○​ Provide opportunities for feedback from attendees regarding accessibility 

●​ Considerations for indoor venues   
○​ Wide doors for wheelchairs and strollers (per the ADA, the minimum clear width  

for a wheelchair is 32”)   
○​ Facility access points with curb lip access  
○​ Hallway space that allows for wide turns  
○​ Adjustable lighting  
○​ Electrical outlet access for laptops and screen readers  
○​ Bathrooms   

■​ Gender neutral options  
■​ Larger spaces for caretakers or self-maneuvering  
■​ Family bathrooms  
■​ Sharps containers  

○​ Microphones for large spaces  
○​ Space for respite from the noise and business of the event (ear plugs and fidgets  

can also help with overstimulation)  
○​ Lactation room  

●​ Considerations for outdoor gatherings  
○​ Provide details on the duration of the any physical activity and how 

strenuous activities are expected to be  
○​ Choose sites with seating, such as benches, or consider bringing some chairs for  

those who may not be suited to standing for extended periods.  
○​ Provide water or ask attendees to bring water  

●​ Be sure to communicate accessibility options to attendees  
 

Other considerations   
Implement based on audience needs and as resources allow.  

●​ Large print options  
○​ Use zoom features within a software program or via assistive technology to 

make text larger and easier to read  
○​ Print resources (brochures, factsheets, etc.) with large-print for individuals 
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with limited vision. According to the Library of Congress19, large print is 
generally considered 16 – 18pt. font  

●​ Braille versions of printed materials  
●​ ASL interpreter  

○​ In-person events or webinars without real-time captioning can be made 
more accessible to deaf and hard-of-hearing individuals by providing an 
interpreter  

● Multilingual versions  
○​ Understand the demographics of the target audience and develop content 

with multiple languages that best support them  
○​ Multilingual versions can also be shared outside of the target audience 

through other partner programs and groups  

APPENDIX A 

Information on the Primary Sources for this Guidance Document  
1. U.S. General Services Administration (GSA) Section 508  

a. On January 18, 2017, the U.S. Access Board published a final rule updating 
accessibility requirements for information and communication technology (ICT) 

covered by Section 508 of the Rehabilitation Act and Section 255 of the  
Communications Act. The U.S. General Services Administration (GSA) Office of 
Government-wide Policy (OGP) is tasked under this law to provide technical 
assistance to help Federal agencies comply with these requirements, and 
ensure that covered ICT is accessible to, and usable by, individuals with 
disabilities.  

b. Accessible Electronic Documents Community of Practice (AED COP) – this 
resource provides guidance on creating accessible Portable Document 
Format (PDF) documents that conform to the Revised 508 Standards  

2. U.S. Access Board  
a. The Access Board is an independent federal agency that promotes equality for 

people with disabilities through leadership in accessible design and the  
development of accessibility guidelines and standards.  

b. The Access Board develops and maintains design criteria for the built 
environment, transit vehicles, public right-of-way, information and 
communication technology, and medical diagnostic equipment under the 
Americans with Disabilities Act of 1990 (ADA) and other laws. It also provides 
technical  
assistance and training on these requirements and on accessible design, and  

 

continues to enforce accessibility standards that apply to federally funded  
facilities under the Architectural Barriers Act of 1968 (ABA)  

c. Americans with Disabilities Act  
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i. ADA is a law that protects people with disabilities in many areas of public 
life.  

d. Architectural Barriers Act of 1968 (ABA)  
i. Standards issued under the Architectural Barriers Act (ABA) apply to 

facilities designed, built, altered, or leased with federal funds. Passed in 
1968, the ABA is one of the first laws to address access to the built  
Environment. 

APPENDIX B 

PDF Remediation Step-by-Step Guide  

All Sources  
1. WebAIM – PowerPoint Accessibility  
2. The National Center for Ecological Analysis and Synthesis (NCEAS) Science 

Communication Resource Corner - colorblind safe color schemes.  
3. GSA – Understanding Accessible Fonts and Typography  
4. Adobe – Picking the right font: Serif vs. sans serif  
5. Canva – 60 sans serif fonts  
6. TPGi Color Contrast Analyzer  
7. Social Security Administration Guide: Alternative Text for Images  
8. American Psychological Association’s Brief Guide to Bias-Free and Inclusive Language 
9. American Psychological Association Inclusive Language Guide  
10. National Center on Disability and Journalism – Disability Language Style Guide 11. 
Environmental Protection Agency - Readability for Developing and Pretesting Concepts, 
Messages, Materials, and Activities  
12. Maine’s Public Universities – Alternative Text Accessibility Guide  
13. The Ohio State University – Alternative Text Guide  
14. University Press of Colorado Alt Text Guidelines  
15. U.S. General Services Administration Visual Style Guide  
16. U.S. General Services Administration - Create Accessible Captions and 
Transcripts 17. Web Accessibility Evaluation Tool (WAVE)  
18. Yale University – Usability & Web Accessibility  
19. Library of Congress – Large Print Materials  
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